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1. Opening Word for Windows

In the PC labs, click on the Microsoft Word icon on the desktop
or under the Start menu, select Programs = MSOffice 2000 - Microsoft Word.
Otherwise, under the Start menu, select Programs = Microsoft Word.

2. Creating a Document

The Word program opens with a blank document. Close this and for this class, open an
existing file in the PC lab: (See the last page of this handout for the text of the file.)

Select File - Open. looen

* From the pulldown menu, select Loak in: (1 Temp -
ClassFiles on ‘Athena’ (F:). ﬁﬁ'esktnp =

- Select the subdirectory My omputer 1. Clickn
g Web Folders  oylldown menu.

Its > Word Class = begword.doc.

=2 3% Floppy (4!)
Click the Open button. oppY

= () 2. Click on ClassFiled

& e
= —§|assFiles on ‘Athena’ (F:
My Documents ZlassDy ‘Athena’ (G:
Look: in: I% ClassFiles on ‘Athena' (Fi) | = Classbiops on Athera’ (5]
| Tacct [(dHec .
e 2 Helpesk You will see a letter that has been started,
= kol Can but not completed.
|:|Bmgt [:IIts
. _Bsa (Lib
“ _dcee (dmath

3. Setting Your Preferred View

Before beginning to work on a document, it is helpful to check the settings under View in the
menu.

* You are in Print Layout View. Use this view when arranging graphics or clip art.
+ Select Normal view and compare. This is a typical view for typing text.
» Return to Print Layout view.
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3. Setting Your Preferred View (cont.)

* Under Toolbars, note that the Standard and |¥iew Inset Format Tools Table indow
Formatting toolbars are checked. If you don’'t see |E Nomal (& 100% -
the toolbars you prefer to use, select them here. Es Web Layaout

EErintLayDut S

- Note that the Ruler is checked and is displayed above |2 Qulin& [l
the document. This shows your margins and tab MT Standard
Settings. v Buler v Formatting

& Document kap Ao Text

« At home or in your office, under
Tools = Customize - Options tab
you may find that the Menus show recently used commands first is checked.

« If you prefer to see all menu commands,
deselect [ Menus show recently used commands first

Note that these settings will be in effect for all of your Office 2000 programs.

4. Usingthe Toolbar

In the PC Labs, the Standard and Formatting toolbars are set to share one row. If you
prefer to have them one above the other, you may either:

e Click and drag the formatting toolbar below the
standard toolbar,

* or from the menu, select
Tools - Customize - Options tab ™ Menus show recently used commands First
and uncheck Standard and Formatting toolbars ¥ Shiow Full menus after a short delay
Sshare one row.

Toolbars I Commands ~ Options

Personalized Menus and Toolbars

W Etandard and Formatting toolbars share one row’

&l Document] - Microsoft Word

J File Edit Wew Insert Formak Tools Table Window Help 1) Grab here.
JD@E|§@|@|:’J-%D|1DD% -@’_’Jﬁ:n; -TimesNewRomanv10v|B
[L] - T N R S B SR |

2) Drag to here. Font Font &i
s . on on IZe
Frint Layout View

Before you begin to add to this letter, note that the font is set to Times New Roman and the
font size is 12 point. The style of the paragraph is left aligned. The default tab stops are
every “zinch.
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5. Entering Text

» Move to the end of the letter by pressing Ctrl + End or by scrolling down and clicking at
the end of the document with your mouse.

* Type in the rest of the message shown below.

* Press Enter only between paragraphs or to create a blank line.

N e T A

Directions to Campus:

1-40 to exit 286 Turn left (north) on Willow Awvenue to University Drive. Turn right onto
Umiversity Drive. Ceontinue on University Drive across Peachtree 5t into the patking lot. Turn
right in the parking lot and find a space. Clement Hall 15 located on Peachtree St across from
the parking lot. Please come to Eoom 220

sincerely,

Tour Name, Academic Computing Specialist
Information Technology Services

6. Saving aDocument

» Select File > Save As.
 To save this temporarily in the PC labs, type c:\temp\gonzales in the
File name box. The document type is Word and ends in .doc

Note: If you are sharing files with others using Word 97, your shar-
ing problems should be minimal. However, if you are sharing with
Save as bype: |w:.r.:| Document (*, doc) others using Word 95, you may wish to save the files in Word 6.0/95
format rather than Word 97 & 2000 format.

File name: IC:'l,temp'l,gl:unzales|

Word will automatically save |RJSUSILE i b3
your document as you work.

Track Changes | Iser Infarmation | Compatibility | File Locations

Wi IGenerall Edit | Print | Sav

To set this in your office:

Save options

™ always create backup copy
» Select =~

Tools = Optlons = Save tab [ Prompk For document properties
+ MAllow baCkg round saves ™ Prompk to save Mormal template
» M Save Autorecovery info B e T

every: 10 minutes. ™ Embed characters in use onky
[~ save data only For Forms
¥ allow background saves

v Save AutoRecover info every: |1EI E‘ minukes

I allow Fast saves
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7. Keyboard Shortcuts

To move the insertion point in a document, you may use the mouse or these shortcuts:

Left or right one character E) E]
Up or down one line D D
Left or right one word @ + E)
Up or down one paragraph @ + D

Page
Up

Previous screen

Home
Beginning of current line :)

Top of document @ 4 Eme)

8. Editing a Document

+E]
0

I
\

Next screen

End of current line

Bottom of document @ + |

End

Page
Down

To insert text into an existing document, use the mouse to point to where you wish to make
an insertion, then single click the left mouse button to move the cursor. Begin typing.

* Move to the beginning of the letter, type today’s date (e.g. February 11, 2002) and

Enter.

* Under General Session, place the mouse pointer immediately after the a in “Please

prepare a...” and single click the left mouse button to move the cursor to this point.

* Type n engaging

To correct text:

+ At the beginning of the second paragraph, place the insertion point after The
» Press Ctrl + Backspace to remove the word The and type Your instead.
« At the end of the second paragraph, double click the word Pass to select it and type

Permit to replace it.

9. UndoingaChange

* From the menu, select Edit = Undo Typing
restore the word Pass.)
» Or from the toolbar, click on the Undo button.

(This will

Note if you click on the down arrow, you will get a pulldown

menu of choices you may wish to undo.

* Use Redo to restore the correction of the word Pass

to Permit

Toals Table “Window Help

% B

List of recent changes.

%Ef;ﬂm
ST Undo Typing|
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10. Formatting Text

|” Morrmal » Times Mew Roman = 10 = Llﬂ

In the sample letter:

» Double-click on Monday in the second paragraph.

+ Click on the italics icon in the toolbar. Then click on bold to get bold and italics.
+ Select Academic Computing Specailst in the first sentence

« Click on the italics icon in the toolbar.

» Select the phrase Directions to Campus

* Click on the underline icon in the toolbar.

To remove a style:
* Double-click on Monday in the second paragraph.
+ Select the italics icon in the toolbar. This deselects the italics style.
» Deselect Monday by single clicking on an area of the desktop that does not contain
text or by using the right arrow key.

11. Selecting Text

TO SELECT DO THIS
Aword Double-click on the word to be selected.
A sentence Hold down Citrl and click anywhere in the sentence.

Click in the margin to the left of the line (sentence)

Aline when the arrow appears.
o Drag in the margin to the left of the lines when the
Multiple lines
arrow appears.
A paragraph Double-click in the margin next to the paragraph

OR triple click anywhere in the paragraph.

Double-click and drag in the margin next to the

Multiple paragraphs paragraphs.

Entire document Triple-click in the margin.

A vertical block of text. Hold down Alt and drag.
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12. Alignment and Spacing
To set the alignment for the entire letter to justified:

. Select Edit = Select All to select the entire docu- | Identsandspadng | e and page ereat |
ment or triple click in the margin.

« Click on the justify icon in the toolbar fn":‘;"t'::ton EDmC
to format the alignment. |= = =/=| Left o = Special:
Right: m (one) 22
To change the line spacing of the last paragraph to a
line and a half: Spacing
i i ) EBefore: 0pt = Line spacing: 4
 Selectthe last paragraph by double clicking in the ater =

lines H [

margin. indle
—._._-."'
« Select Format = Paragraph from the menu. Preview Double
. . . Ak leask
« Select 1.5 lines from the Line spacing pulldown R e A B At e ety
menu Liuserucy Dnve  Conarue en Unavermny Onve s Peachre| VU ET L2

+ Click OK.

13. Moving Text

To move text, you cut it from one location and paste it into another.

+ Select the second sentence of the second paragraph, “Please come to ...” by holding
down Ctrl and clicking anywhere in the sentence.

Select Edit = Cut or in the toolbar click on the Cut (scissors) icon.

Move the insertion point to the beginning of the second paragraph.

Select Edit = Paste or in the toolbar click on the Paste (clipboard) icon.

Click on Undo to undo this change.

|Paste |

D2 ERY dmEda-
Save *Spelling|

The Office Clipboard allows you to copy and paste multiple items. You can gather items from
other Office programs and then copy each item into your Word document.

B BT -

e¢ HEs

. . Clipboard (6 0f 12) E
From the menu, View = Toolbars M Clipboard B0 ) este Al B
+ Click the copy icon on the Clipboard to copy an item to it. @Cﬂﬂ% % %
» To select an item to paste, click on the icon for that item. % % r r

14. Saving After Update to the File

To quickly save your file after making several changes: Click on the Save icon in the toolbar.
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15. Spelling and Grammar Check

Words which this program considers to be misspelled are marked with a wavy red under-
line. Sentences which may be ungrammatical are marked by a wavy green underline.
You can make corrections as you go along or you can run the spell check program which will
provide you with suggested spellings.

 Right click on the word Specailist in the first sentence.
» Note that you may select the correct spelling from the pop-up menu.

To check your entire document:

Spelling and Grammar: English (U.5.)

Mot in Dickionary )

» Select Tools = Spelling and

G Thank you for your interest in the Academic ﬂ Ignare I
ran_]mar . Computing Specajlistg position. : ol
 Orclick on the Spelling and oA |

Grammar icon in the toolbar. = Add |
Suggeskions:

« Click Ignore to keep words that Eﬁp_jecialists A e |

are not actually misspelled, Chang= Al |

+ Or select a spelling from the list = autacorect |

of suggestions,
» Or type your edit into the top W Check grammar
box. @l Ophians. .. | Unda | Cancel |

 After completing the spelling check, any words or phrases will no longer show in your
document with a wavy red or green underline if you selected Ignore (indicating that
the word was correctly spelled or the phrase was grammatical).

16. Using the Thesaurus

Word includes a thesaurus to help you find words with similar or opposite meanings.
In the sample letter:

« Select qualifications under General Session.

» Select Tools = Language - Thesaurus

+ Select a synonym, such as credentials, from the suggestions.
+ Click the Replace button.
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17. Setting the Margins

To set the margins, paper size and general characteristics of your document:

» Select File = Page Setup.

Click into the box for the left margin.

» Type 1.5 or use the arrows to increase the size to 1.5 inches.
 Click on the Paper Size tab

Note that the paper orientation is set to Portrait

Click OK.

18. Setting Options

Word allows you to set several different options that may help you in your work.

Formatting Marks

» Select Tools = Options = View tab.
» Under Formatting marks, you may elect to see some or all of these by checking the
appropriate box.
« Or you may show and hide these marks by using & W 100% =
the Show/Hide formatting button on the toolbar.

2= ShowiHide 9|4

Editing Options

« Under the Edit tab, you may turn off the box “When selecting, automatically select
entire word’. If this is off, you can more easily use dragging to select parts of words to
correct.

» Explore each tab to see what choices are available.

You may also want to change some of the settings under Autocorrect.

» From the menu, select Tools - Autocorrect

« Several options are selected such as M Capitalize the first letter of sentences.

+ In addition, a list is provided of automatic replacements for common typing errors, such
as replacing abbout with about. You may add to the list if you know specific typos you
are prone to make.

Default font

» From the menu, select Format = Font = Font tab.

» Select the font name, size and style you prefer from the pulldown menus.
 Click on the Default button near the bottom of the popup window.

+ Click Yes to apply your choice.
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18. Setting Options (cont.)

Office Assistant

» To set your preferences, select Help = Hide the Office Assistant
o Help = Show the Office Assistant

To turn the Office Assistant off for an entire session:

Select Help = Show the Office Assistant,
Click on Options

Select the Options tab,

Deselect V1 Use the Office Assistant

Click OK.

19. Printing and Exiting

To print a document:

» Select File = Print.

+ Click on OK in the dialog box.
OR click on the Print button in the toolbar. Note that this will
cause printing to occur immediately.

le Edit Yiew |nser

File E
= = E A

To exit the program: Select File = Close or use the close boxl in the upper right corner.

Note: Ifyou have made a change and have not yet saved, when you exit a prompt will
ask if you would like to save your changes.

20. Creating New Documents

Word 2000 allows you to create several types of documents. These include a blank docu-
ment page, an email message (sent in HTML format), and a web page (HTML format). You also
have a choice of several designed formats for memos, faxes, etc.

From the menu, select File = New and choose the style you desire.

Note: In general, it is preferable to create web pages in a program such as FrontPage, rather than
Word, due to the kind of HTML code Word creates.
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21. Getting Help

One of the easiest ways to get help with Microsoft Word is the comprehensive online

help included with it.
Help - Microsoft Word Help.

You can also learn more
about Word at the Microsoft
web site:
http://office.microsoft.com/

Should you have a question

that the online help does not
address, please contact the

Microcomputer Support

H Microsoft Word Help
& = SHEr

Office at 372-6315 or your

college contact.

 Students may call the Help

Contents | Answer Wizard I Index

@ What's New?
& Getting Started
= ([ Getting and Using Help
@ Wyay's to get assistance
@ Using the Office Assiste
& Programming Help
@ todifying and Printing ¢
& OtherWays to Get Help
@ Using Word it You Have a
& Installing and Remowving '
@ Running Programs and Me
& Creating, Opening, and Sa
@ Finding Files

o |:,-\|;;;.-.,I el oo o Tondt

<

-

@& Typing, Navigating Docirl_l
»

|| more help on the Web at the bottorn of the list

Ways to get assistance while you
work

This topic provides reference information about:

Asking for Help from the Office Assistant

Getting Help from the Help rmenu

Getting Help from the Office Update Web site
Finding out what's new in Word 2000

Maore information

Asking for Help from the Office Assistant

Wwhen you have a question about a Microsoft
Office program, you can ask the Office Assistant,
For example, to get Help about how to create a
table, type How do I create a table in the
Assistant.

If the correct topic doesn't appear in the Assistant
balloon, click None of the above, look for
v|

Desk at 372-3975 or get assistance in the PC labs in person.

« Handouts on using Word and other programs are available on the web from the TTU
home page under Computing = Documentation (at http://www.tntech.edu/its/pubs/).

22. Beginning of the Sample Letter

M. Mike Gonzales

super Computer Company
1240 Nerth Vista Street
Cooleyille, TH 28501

Dear Mr. Gonzales:

The schedule 1z as follows:

100 p.m.
130 pom.

200 pom.
230 potn.

Crentation and overview
GJeneral Session

Please prepare a 15 minute presentation on how wour qualifications fit this
posttion and what assets vou bring to the position

Academic Computing Support Staff
Closing

Thank you for your interest in the Academic Computing Specailist position

The interview has been scheduled for next Monday beginnning at 1:00 p.m. Please come to
Cletnent Hall, Room 220 where you can pick up a a Guest ParkingiPass.
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